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Google Data Studio

Most Common Workflow
• Connect to Data
• Visualize within Report
• Share Report 

Reports
• View all reports you have access to
• Filter by ownership
• Search by name
• Sort by name, ownership, or date
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Data Sources
• View all data sources you have access to
• Filter by ownership
• Search by name
• Sort by name, ownership, or date

Explorer
• In Beta mode
• Designed for quickly editing, viewing, and filtering
• Acts as a scratchpad
• Private only to you; may not be shared directly

Data Source Tab
• view all data sources you can access 
• open a data source 
• edit the data source
• control which data can be visualized in reports
• Control how data appears
• Control who has access to view or download the data
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Clicking on a Data Source
• see and edit the data source fields and settings
• edit the connection
• create reports from the data source

What the Data Source shows 
• the schema of your data set, with information about each of the 

fields. 
• A field contains the information -- the metric or dimension -- that 

appear in reports
• It is common for each field to have attributes assigned to it
• The “Field” column lists metrics and dimensions by name. By 

default, the field name will come from the connected data set, 
and you can change these names if you wish. (Remember that 
changes made to the data source will affect all affiliated reports.)

Working within Data Source
• Can create new data source fields by clicking three dots
• Count
• Count Distinct
• Duplicate field
• Disable field (can’t use in reports referencing this data source)
• Remove – permanently deleted
• Data TypeSelecting appropriate type ensures data flows into 

reports properly
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Aggregation 
Refers to how the data is structured, i.e., if it groups values together 
at all.
In Data Studio, fields can have the following aggregation methods:
• Average
• Count
• Count Distinct
• Max
• Min
• Sum
• Auto
• None

Description provides you with details about what 
is captured in the specific field.
• This input is optional, used for your reference.
• “Add a field” allows you to create a 

new metric or dimension derived from your 
existing data. For example, you could create a 
new metric that represents the average of a 
metric, the sum of the values of a dimension, 
or the ratio of two different metrics.

Editing fields in data source
Fields edited within the data source only affect Data Studio's 
representation of the data and don't affect the underlying data set.

Refresh Fields
• updates from the underlying data
• New fields appear 
• Any changes are reflected.
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Data credentials
• Controls who has access to view data in reports. Options include  

owner’s credentials, which allows anyone who is invited to view or 
edit a report representing this data source can see this data in 
charts. This is because the owner can allow viewers to use their 
own credentials for the purpose.

• Other option is Viewers credentials
• Owner decides which to apply for others who are viewing the 

data in reports

Community Visualizations Access
Setting determines whether custom visualizations by third-party 
developers can include information from your data source.

Field Editing in Reports 
• Toggle lets you enable or disable field editing at the report level. 

This determines whether field changes can be done at the report 
level. New data sources have this option turned on by default.

• Field editing in reports” setting allows report editors to make 
changes to metrics and dimensions, such as renaming fields, 
changing data type, changing date output format, comparing 
metrics to totals, applying running calculations, and more. 
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Data Source Changes
• Changes made to the data source apply to all reports referencing 

that data source.  This is why it’s important to be cautious when 
inviting others to edit a data source, and also why having a data 
source is useful!

• Your underlying data set may contain data you don’t need or 
want in your reports, may use field names you’d want to change 
for readability, or may be missing critical information you’d want 
to include in your data visualizations.

Common Edits to Data Source
• Disable a field
• A data source may have a lot of excess information that you won’t 

need or want to reference in your reports. If there are metrics or 
dimensions you want to keep out of Data Studio reports, you can 
disable that field, and it won’t fill any charts in your reports.

• Rename a field
• The names of your metrics and dimensions may not be as user-

friendly as you want your reports to be. In the data source, re-name 
such fields for clarity and consistency.

Common Edits to Data Source
• Create a new metric or dimension that is derived from your data. 
• You’ll input a formula instructing this new calculated field to perform 

arithmetic, manipulate text, date, and geographic information, and 
use logic to output a new field that can be displayed in your report’s 
charts.

• Disabling a field
• Keeps proprietary or PII information from showing in any reports 

based on the data
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Report Viewing
Pages selected along left side

Report actions 
Found in top right
• Download the report
• View it full-screen
• Refresh the data
• Make a copy of the report
• Share it with others

Toggle between Edit and View 
modes
• Report Canvas May include
• Charts
• Tables
• Text
• Shapes
• Images
• Scorecards
• Date report was last refreshed is shown in bottom left
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View mode vs. Edit 
mode

Controlling Report Structure
• Layout Controls
• Report Controls
• Page Level Controls

Theme and Layout 
Controls
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Header visibility
The header visibility options control the behavior of the report 
header in view mode. The header contains things like the report 
title, the share button, and edit button.
• Always show report header
• Auto hide report header
• Initially hidden report header

Navigation position
Control where pagination navigation option appears in a report. 
Options are Left or Top.

Display mode
• Sets how report fits within browser window.
• Fit to width scales the components in the report in proportion to the 

width of the window.
• Actual size displays the report components at the same size they 

were created.
• Has margin shows or hides the margin area surrounding the report. 

Hiding the margin makes the report appear to occupy the entire 
window.
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Canvas Size
• Select a preset size or enter custom dimensions. Preset sizes 

include:
• US Letter (4:3) - Portrait
• US Letter (4:3) - Landscape
• Screen (16:9) - Portrait
• Screen (16:9) - Landscape

Snap To
• Snap controls how components in a report are positioned.
• Smart guides display colored lines to help you align, resize, and 

space the selected components:
• Align components: while moving a component, a red line appears to 

show when it is aligned with other components on the canvas.
• Resize components: while resizing a component, blue lines appear to 

show when that component is the same length or width as other 
components on the canvas, and the current size in pixels is also 
shown.

Snap To
• Space components: while moving one or more components, blue 

lines appear when those components are spaced equally with other 
components on the canvas.

• Grid aligns the selected components to the visible grid on the 
report canvas.
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Grid
Make the grid visible within the report canvas using the View menu.

Grid Settings
The minimum canvas grid size is 10 px. You can adjust this with the 
Grid Settings options. Increasing the grid size makes it easier to 
layout your charts, controls, and other components.
• Size sets the height and width of the grid squares.
• Padding adds space within the grid squares. Use this to separate 

components in adjacent squares.
• Horizontal offset sets left and right margins on the edges of your 

report. Use a positive number for left offset. Use a negative number 
for the right offset.

Grid Settings
Vertical offset sets top and bottom margins on the edges of your report. 
Use a positive number for top offset. Use a negative number for the 
bottom offset. Use this to provide space for headers and footers.
• Changing grid settings has no effect on components already on the 

page. It only applies to new components you add, or to components 
that you move.

• When you place a new component on the canvas that can fit into one 
or more grid squares, the component "snaps" in position and fills the 
grid, making it easy to size and line up new components in rows and 
columns. ("Fill the square" behavior begins with a grid size of 15 px or 
greater.)
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Report-level component 
positioning
• Specifies how report-level components are positioned relative to 

other components.
• Top positions report-level components in front of all other 

components (similar to using Bring to front).
• Bottom positions report-level components behind all other 

components (similar to using the Send to back).

Arrange, group, and distribute 
components
• Use the Arrange menu to control the layout of the components in 

your report. To use these options, select one or more 
components, then select the desired alignment option from the 
menu.

• You can access all of these options by right-clicking (or control-
clicking) a component or group of components.

Order options
The order options control how objects appear in front of or behind 
other object.
• Bring forward—causes the selected component(s) to "take one step 

forward" in the display order.
• Send backward—causes the selected component(s) to "take one step 

backward" in the display order.
• Bring to front—causes the selected component(s) to appear in front 

of all the other components on the page.
• Send to back—causes the selected component(s) to appear behind 

all the other components on the page.
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Align and Distribute
• Alignment helps arrange components so they line up, either 

vertically or horizontally. Select 2 or more components, then 
choose the horizontal or vertical alignment axis (top, bottom, 
right, left, center, etc).

• Use the distribution options to adjust the amount of space 
vertically and horizontally between 3 or more components. This 
option uses the positions of the leftmost and rightmost 
components (for horizontal distribution), and the topmost and 
bottommost components (for vertical distribution) as "anchor 
points." It then moves the selected components so they are 
evenly spaced in the specified direction.

Make Report-Level / Make 
Page-Level
• Components only exist on the page where they are created. For a 

component to appear on every page, make it a report-level 
component.

• Use Arrange > Make Report-Level.

Group / Ungroup
• Grouping components has several benefits:
• It makes it easer to move them as a unit and to preserve their 

arrangement.
• You can edit the DATA tab options of grouped components as a 

unit. 
• Report controls, like a date range controls, can be applied only to 

charts in a group that includes them.
• You can't group page-level components with report-

level components.
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Data Source

Credentials
Owner’s vs. Viewer’s Credentials
• Determine if report can be viewed by all, as if they had owner’s 

access to the data, or only viewed by specific people who have 
received access.

Date Range Controls 
• Data source must include dates to use date controls
• GA Defaults to showing past 28 days
• Date Range for entire report set as Page Property
• Can allow viewer to customize date range by placing Date Range 

Controls within report
• Dates apply to entire report by default
• Date Range controls can be limited to single object by grouping
• Date ranges can be absolute or relative
• Individual charts can have separate date ranges
• With chart selected, specify Date Range Property
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Date Ranges
• Auto date ranges are set as the default based on the data source 

for the selected chart. For example, Google Analytics defaults to 
the last 28 days from yesterday.

• Fixed date ranges specify exact beginning and ending dates. For 
example, January 1, 2019 to January 31, 2019. Charts with this fixed 
range will always show data for those dates only.

• Preset date ranges give you options such as "Today," "Last week 
(starts Monday)," and "This year to date." Preset date ranges are 
relative to "today" and adjust as time passes.

• Advanced date ranges let you create flexible custom rolling dates.

Comparison date range
Some charts can compare the current date range to another range 
in the past. For example, in a time series, the comparison data 
appears as a line of a different color from the current data. In a 
table, the comparison data is shown as the delta from the current 
data, with an increase or decrease indicator.
• Set up a comparison date range
• Select a time series, table, area 

chart, or scorecard.
• On the right, in the DATA tab of the 

properties panel, scroll down to the 
Default Date Range section.

• Under Comparison date range, 
choose the comparison period.

• Click APPLY.
• Dates within tables can also display 

as quarter, year and quarter by 
changing the Show As option.

Drill-down charts & graphs
• Turn on drill-down for a chart
• Edit your report.
• Select a chart.
• On the right, in the DATA properties panel under Dimension, turn on 

Drill down.
• Add dimensions to the chart. Each dimension you add becomes 

another level of detail you can drill into.
• Select the Default drill down level.
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Filter Controls
• Allow User to filter what appears in report
• Add a filter control then choose a Dimension which users can select

Filter controls are dimension-only
• Filters are report-level by default
• Filters can apply to individual components via grouping
• Can be check-box, expandable list, single select, or search box

Add a filter control to a report
• Switch to Edit mode
• In the toolbar, select Filter control 
• Draw the filter control on the page
• On the right, use the Filter Control Properties to configure the 

filter control options.
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Charts as interaction Filters
• Charts can filter data across a report or in other charts
• Eg: selecting a pie chart item can control another chart

Adding chart interactions
• Switch to Edit mode
• Select a chart.
• On the right, view the DATA properties panel.
• In the Interactions section, select Apply filter.
• Repeat these steps for each chart you want to use as a filter.
• Filters can be applied to other filters

Data Control allows 
viewers to select 
different data source
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Add hyperlinks within reports
• Links to external web pages
• Links to specific pages within report
• Links to relative pages within report

Download data from Charts and 
Tables 
• Use the menu in the upper corner of each table or chart
• Disable this option via Sharing options under Manage Access

Filters 
• Filters can be applied at:
• report 
• page
• chart / table
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Organizing filters
• Filters can be modified for each item within Data section of 

control panel
• All existing filters can be managed under Resources menu

Embed External Content
Embed URL option allows video, full websites, Google Sheets, any 
other web-accessible content to be embedded in Data Studio 
report

Optional metrics
You can make your charts and tables more flexible by adding 
optional metrics. This lets your viewers select which columns or 
fields to display in the chart.
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Adding optional metrics
• Edit your report.
• Select a chart or add a new one
• On the right, in the properties panel under Metric, turn on 

Optional metrics.
• Click +Add metric or drag the metric from the Available fields 

panel.

Segments
• GA Segments can be applied within Data Studio
• Segments are System, Custom, or Shared
• Custom and Shared segments must first be added to GDS

About Segment types
• System: predefined segments available to all users in any view. 

You don't need to do anything special to use these in your Data 
Studio reports.

• Custom: user defined segments. These can include custom 
metrics and dimensions.

• Shared: segments that have been shared with you by other 
Analytics users.
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Segment can be applied to
• Report
• Page
• Components

Adding Charts, Tables, 
Scorecards & Maps

Adding Fields in Charts 
& Tables
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Styling Charts

Changing Chart types

Chart types
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Area charts 
Area charts let you visualize a single dimension (the breakdown 
dimension) and a single metric, plotted over time. An area chart is a 
variation on the line or time series chart. It uses shaded areas under 
the plotted lines on the graph to indicate the volume of data 
represented by the lines. Like a time series, area charts are useful for 
seeing how your data trends over time.

Bar charts 
• You can use a bar chart in Data Studio to look at your data in 2 

distinct ways, depending on the number of dimensions in the 
chart. When your chart includes a single dimension, the data 
series come from your metrics. 

• You can show up to 5 metrics in a single dimensional bar chart.
• When a bar charts includes 2 dimensions, the data series come 

from the second dimension. Two dimensional charts can show 
any number of data series but only 1 metric.

Bullet charts 
Bullet charts in Data Studio visualize a single metric. You can 
optionally display a target value and set up to 3 ranges.
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Combo chart
• A combo chart lets you use either lines, bars, or both to visualize 

your data. Combo charts can plot both time-based and non-time-
based data on the X-axis.

• Combo charts can plot a single dimension with up to 5 metrics, or 
2 dimensions with a single metric.

Geo maps
• A Data Studio geo map requires you to provide 3 pieces of 

information:
• a geographic dimension, such as Country, City, Region, etc.
• a metric, such as Sessions, Units Sold, Population, etc.
• the map's zoom area.
• Use filters to focus zoom area on a specific country

Pie charts & Donut Charts
• Pie charts display your data in a circular visualization, with 

sections (slices of the pie) representing your data series. The sizes 
of the slices are proportional to the quantity or relative value of 
the metric you are plotting. In general, pie charts are most useful 
when comparing a few data points with relatively large 
differences in proportion between the values. Pie charts that 
display large numbers of series with minor variations in the data 
can be confusing to viewers of the chart.
• Support 1 dimension & 1 metric
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Pivot tables in Data Studio
Pivot tables in Data Studio take the rows in a standard table and 
pivot them so they become columns. This lets you group and 
summarize the data in ways a standard table can't provide.

• Options:
• Show totals
• Expand-collapse

Limited to:
• 2 column dimensions.
• 10 metrics.
• 3 pivot tables per report page
• 50,000 rows of data

Tables
Tables display data in a grid of rows and columns. Each column 
represents a dimension or metric, while each row is one record of 
your data.
• Header Settings
• Color for header, border, 

rows (even and odd)
• Typeface options
• Row numbers

• sPagination (1 of X)
• No data options (Null vs. 0)
• Alignment
• Background & border

Chart headers
• Display options for downloading, sorting, and exporting
• Can be disabled for each chart
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Scorecards
Scorecards display a summary of a single metric. Scorecards are 
commonly used to visualize key performance indicators: some 
variable that measures the relative health or performance of your 
business or area of activity. For example, a scorecard can summarize 
total sales or average bounce rate.

Time series chart
A time series chart shows how your data changes over a period of 
time. For example, you can display the count of website sessions 
daily over the course of a week

Treemaps
• Data in a treemap is displayed in "branches" (also called "nodes"). 
• Each branch can have sub-branches, and one parent branch 

(except for the root, which has no parents).
• Each branch is displayed as a rectangle, sized and colored 

according to the values in your data. Sizes and colors are valued 
relative to all other branches in the graph.
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Customizing Reports
• Text
• Lines & Shapes
• Images

Sharing
• Get link
• Email – schedule delivery
• Share
• Download
• Export
• Embed a report in another site 
• Set sharing options "Public on the web" or "Anyone with the link can 

view"
• Select File > Embed report, or in the upper right, click Embed.
• Click Enable embedding.

Create Thumbnail
• Must have view permissions to see 
• Share as src for <img> tag
• Can copy/download then use elsewhere without permissions
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